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Introduction

The Lightroom application allows us to look at, search, organize 
and edit our photographs. It works with Photoshop to give us a      
complete set of tools for our photographs. It can also be used to 
organize videos for video projects.

This tutorial is designed to introduce you to Lightroom and give 
you a basic set of skills. As with Photoshop, Lightroom offers many 
many features that are beyond the scope of this tutorial.

It is NOT designed to detail every single feature of the program.
IT is specifically written for Lightroom Classic 2019 and is current 
as of May 2019

NOTE: Lightroom now comes in two varieties. 
	 Lightroom Classic is for desktop based assets - your photos 
are on your computer or external hard drives.
	 Lightroom (not classic) is for workflow where you store 
your images in the cloud. The two programs are NOT               in-
terchangeable.
	
This tutorial will look at these key features of Lightroom
	 1.  Importing Images from your camera

	 2.  Cataloging Images for archiving and organization

	 3.  Toning/Editing/Captioning Photos

	 4. Sharing photos

•
NOTE:  This tutorial 
was written for the 

Mac OS. 
But the program 

should look very similar 
on a 

Windows computer.
There is a tablet      

version of Lightroom 
as well - it offers 

fewer features than the    
desktop version.

•
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•
If you want to 
learn more about       
Lightroom one great 
resource is Lynda.
com.
The site offers       
tutorials on a wide 
range of applications 
and is free to Penn 
State students.

•

Confused about 
a Module?  
Help>Module Tips 
will offer some simple 
guides and changes 
depending on which 
module you’re in.
Watch this :57 video 
to see how to access 
the help.

•

Tools and Workspace

Lightroom Classic(from now on, when we say Lightroom know that 
we mean the Classic version) is part of the Adobe Creative Suite of 
applications. This means the look and interface will feel familiar as you 
move from app to app, from Lightroom to Premiere to Audition to 
Indesign, etc. 

Lightroom is complicated.  In some ways trickier than Photoshop 
because it does many different things.

It is organized in two broad ways:

Modules    Panels

Modules There are seven Modules within Lightroom. Select the 
one you need based on what you want to accomplish. This tutorial 
will focus on the Library and Develop Modules.
Library  	 Where you’ll import, store and organize your photos
Develop 	 Where you can adjust and edit photos
Map 		  Let’s you see where your photos were taken
Book		  Design books for printing or making PDFs
Slideshow	 Create Presentations
Print		  Print or prepare photos for printing
Web		  Create Web galleries for uploading to a server

Panels are how Lightroom organizes its tools and controls. By 
default you’ll see four panels set around the center display of your 
images.  Watch this 1:24 video on how to adjust the Panel view

http://Lynda.com
http://Lynda.com
http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#help
http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#help
http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#help
http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#panes
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When you open Lightroom you should see something like this.
Note that we are in the Library Module.

Catalog

When you first open Lightroom it will ask you to create a catalog. 
This is where all the information for your photos is stored.

Lightroom does NOT move existing folders of photos. By default it 
does not make copies of existing photos. It WILL copy photos from 
your card or camera.

It makes a catalog that you can search and organize so you can find 
your photos.
Typically you will have just one catalog for all your images.  You can 
sort and organize within that one catalog.

•
By default Lightroom 
will store your catalog 
in the Pictures folder 
on your computer.

You can move your 
catalog. Shut down 
LIghtroom and drag 
the folder from the 
Pictures folder to 
anywhere you like.
When you reopen 

Lightoom you’ll have 
to point the program 
to the new location 

of your catalog.
•
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IMPORTANT

A catalog is NOT the actual photos.  Think of it as the 
table of contents to a book or a catalog for a clothing store. 
The actual clothes are not in the catalog. The actual words of 
the book are not in the index. 

They are the guides that tell you what is in the book or store. 
A Lightroom catalog does the same thing.  You can look at 
previews and metadata and even adjust your photos. But the 
actual files exist on their own, separate from Lightroom.

Lightroom points to the actual photos. So that connection is 
important. If you move the photos Lightroom will not be able 
find them.

Importing Photos
You can import photos from an existing folder or hard drive 
into Lightroom.  By default this doesn’t copy or move the 
photos, it simply adds their information to the Lightroom 
database.

You can also import from a camera, or SD card or smart-
phone.  In this case, by default, the photos ARE copied to your 
computer or hard drive.

This makes sense. You want to get the image files off the  
camera or phone or SD card and stored on your computer 
or external hard drive (or, ideally, both)

To Import photos, click the Import button at the bottom left.

•
Remember to 
back up your    
images. If you’re 
using LIghtroom 
to import from 
your camera you 
can have it copy 
your files to a  
second location. 

Think about    
creating a     
workflow that   
automatically 
backs up your   
images. 

Have two external 
hard drives, or use 
Box.com for one 
set of backups.

•

http://Box.com
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•
If you’re importing 
a folder with sub 
folders make sure 
to click the 
‘include sub folders’ 
checkbox.

if you’ve selected 
a folder and don’t 
see any images in 
the center panel it’s 
probably because 
you didn’t check 
the sub folder box.

•
Set the Lightroom 
preference to 
‘show import 
dialog when a 
memory card is 
detected’  
LIghtroom>Prefere
nces...>General

This is the Import Dialog box

1. Select the device. In this example there is an SD card called ‘Un-
titled’ and an iPad.  The SD card is selected and we see the images on 
the center of the dialog box.

2. If you’re importing from a device, select ‘copy’. You want to copy 
the images from the device to your computer or hard drive as well as 
catalog the images. IF you were importing files that already existed 
on your computer you would select ‘add’ to add them to the cata-
log without making another copy.

3.  I recommend setting build previews to ‘Standard’ and selecting 
‘Build Smart Previews’  Smart Previews will allow you to work on an 
image even if the actual file is offline on another hard drive. 
You can make changes to the Smart Preview and then when you 
connect the hard drive those changes will be applied to the actual 
file. Pretty nifty.

Select a destination for your photos. Find a system that works for you.
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You can also select a second destination and have Lightroom make a 
second set of copies of the actual image files.  Definitely a good idea!

4. Under Metadata, you can create a custom caption with your      
personal information and have it applied to every photo. Add your 
name, copyright information, etc to every image. Another smart idea.
Metadata>New  will let you create a preset you can apply to every 
photo.
OR, create a new preset each time and add more details about that 
assignment. You could write the basics of a caption here and then later 
add specific details to specific photos.

5. Typically you’ll import every image from a card or camera. But if you 
don’t want to, you can uncheck images and only import the ones you 
check.

Watch a 8:28 video on importing into Lightroom

Using the Catalog

Once we’ve imported photos, we have a catalog. An index/view/cata-
log of all our photos.

This is the heart and soul of Lightroom
Notice the settings in this sample Catalog

We are in the Library Panel

The display is broken into three columns.
	 The first column lets us navigate to the images we want to view. 
In this case we are looking at a subfolder called Tuesday-Thursday 
which is just one folder in the external hard drive that this catalog is 
based upon.

•
Be organized at this 
step and everything 
gets easier.

Apply metadata – 
as much of a cap-
tion as you can.             
Organize your files 
using   subfolders if 
necessary.

You could create 
folders by date or 
subject. Whatever 
makes logical sense 
to you.

•

http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#import
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	 The second column is the image view. This is called the ‘Grid’ 
view.  Rows of small thumbnails. You can scroll up and down to see 
additional images.  Double click on an image to view what is called 
the ‘Loupe’ view, a close up of the photo. Double click again to re-
turn to ‘Grid’ view. 
	 You can tag photos in three ways. 
		  Assign a rating by clicking 1-5 stars
		  Click the ‘flag’ to flag the photo
		  Click the small square to assign a color
Watch this 2:40 video on using a Catalog
All of these methods are searchable.
Searching a Catalog

You can search within whatever group of photos you are viewing in 
several ways.

You can search by text – that could be file names or caption         
information.

•
Switch between 
‘Grid’ and ‘Loupe’ 
mode by dou-
ble clicking on 

an     image, or by        
using the small 
tabs below the          

images or by using 
the quick keys: G 

for Grid view and E 
for Loupe view.

•

http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#catalogue
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You can search by attribute – color, rating, flags.

You can search by metadata – any of the information contained in 
the metadata field. This could be the kind of camera, the location, the 
date shot, etc.

The search options are located above the image(s) except for the at-
tributes which are both above and below.

In the example above, ‘Text’ Search is selected. You have multiple ways 
to filter a text search using the dropdown menus.

Watch a 3:04 video on searching a catalog

http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#search
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Viewing Images

Looking at your photos, and selecting your favorites is a core feature 
of Lightroom.

The program offers a variety of ways of viewing and comparing      
images.
Grid & Loupe View
Compare
Survey

Grid and Loupe view

Grid View means you’re looking at a group of images in rows 
of small thumbnails. Select Grid View using the small button in 
the lower left
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Loupe View means you’re looking at a single image, close 
up. Select Loupe View using the second small button in the 
lower left.•

There are multiple 
ways to switch 
between Grid and 
Loupe views. 
1. Use the      
buttons at the 
bottom of the 
screen.
2. Double clicking 
on an image will 
move you from 
Grid to Loupe 
and back again. (I 
think this is the 
fastest method)
3. Use the quick 
keys:
G for Grid
E for Loupe

•

Watch a 2:09 video on using Grid and Loupe views

Compare Lets you look at two images, side by side. Very 
useful if you’re looking for subtle differences in expression or 
moment.

Click the Compare button or use the quick key C.

If you have one photo selected, Compare will show you the selected 
photo and the very next image, side by side.

If you select two photos and then select Compare, you’ll see those 
two images side by side.

http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#grid
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Zooming
Notice the zoom tool under the images in Compare mode. If you 
leave the lock icon locked, you can zoom on both images at the 
same time.

If you unlock the zoom tool you can zoom on one image or the 
other. Click the ‘synch’ button and the two images will be magnified 
at the same amount.

The image on the left is the ‘Select’. Use the film strip at the bottom 
to choose a different photo. 	 It’s the first image you choose. 
You can use the arrow keys to scroll through other images in the 
‘Candidate’ window.

Watch a 2:58 video on using the Compare Tool.

http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#compare


Lightroom Classic

      Tips & Tricks

updated May 2019
14

Survey Lets you look at a group of images. If you’ve nar-
rowed your selections down to a handful of images, Survey 
can help you make that final selection.•

There are some fun 
and useful ways to 
change the view in 
Lightroom.

The Tab key will 
remove the side 
panels and the Shift/
Tab keys will elimi-
nate all the panels.

The ‘L’ button will 
darken the back-
ground. Lightroom 
calls this ‘Lights Out’

The ‘F’ key will show 
you an image in 
full screen mode. A 
great way to show 
off your photos to 
other people.

Watch a 2:05 video 
on these view op-
tions

•

Simply select multiple photos by holding down the command key(on 
a mac) or control key (on a PC) and clicking on photos.

Once selected choose the Survey button at the bottom or use the 
quick key ‘N’ to enter Survey mode. 

Once in Survey mode you can remove 
a photo by rolling over it and using the 
‘x’ button to remove it from the survey. 

Watch a 1:36 video on using the Survey tool

http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#view
http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#view
http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#view
http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#survey
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Naming, Finding, Moving Photos & Folders

It is very easy to move folders and images and rename them 
within Lightroom

Lightroom gets very unhappy if you move or rename photos or 
folders outside of the program.

If you remember those two rules, you’ll find working with Lightroom is 
much easier.

Within Lightroom you can drag and drop folders and photos from 
the Catalog column on the left.

Rename a photo or folder. Right click on a folder 
and select ‘rename’.

You can also simply click 
and drag a folder to a 
new location.

From the Loupe view 
you can drag a photo to 
a new folder.

Select a file or files 
from the grid and use 
Library>rename to 
change the file name. 

All of this is done within the LIghtroom program and makes Light-
room very happy. 
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IF you move a photo or folder while outside the program, Lightroom 
will lose the connection to that photo or folder.

You will need to reconnect the content with Lightroom.

In this example, I renamed a folder outside of Lightroom. 

From Lightroom’s point of view, that folder is gone, missing, kaput. It 
can’t find it.

Notice the question mark over the folder and the small box in the 
upper right of the thumbnail.  

Because I generated a Smart Preview when I imported the folder,  I 
can see the image. But the actual file is gone as far as Lightroom is 
concerned.

If you click the Locate button you can navigate to the newly renamed 
folder and reconnect it to Lightroom.

BEST PRACTICE:  Move folders and photos and rename them 
within the Lightroom program.  Make that your workflow to avoid 
problems.

Watch a 3:55 video on renaming and moving and reconnecting 
photos and folders.

http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#find
http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#find
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Video Files

Lightroom can catalog and display video files as well as still photos.

Import video just as you would still images. Lightroom will catalog 
video files along with your still images.

Video Files will show a time code in the Grid View

To play and hear your clip, 
look at it in Loupe View.

You can change the thumbnail image of the video, known as the 
Poster Frame and you can extract a jpeg of any frame within a video 
right inside Lightroom.

Capture Frame will 
create a jpeg of the 
frame of video and 
store it in the same 
folder as the video

Set Poster Frame 
will change the 
thumbnail that is 
displayed in Grid or 
Loupe views.

•
You can search for 
video files within 
Lightroom by creating 
a new column and 
selecting file type in 
the Metadata search 
tab.

Under the Metadata 
search, click on the 
small dropdown in 
any column to add a 
new column

After adding a new 
column, Change 
‘None’ to File Type 
by using the drop-
down menu.
You can then search 
for files by type 
including Video.

•
Watch a 3:31 video on viewing Video Files in Lightroom

http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#video
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Using Ratings and Labels

To fully use the power of Lightroom you’ll want to be familiar with 
rating and labeling your photos.

The options and ability to customize Lightroom is almost over-
whelming.  Once you find a workflow that fits yours needs, and you 
become comfortable with the quick keys and options, Lightroom can 
be a very powerful tool for organizing and finding your photos.

Rating your images

Lightroom offers three ways to label/rate your images
Flags
Stars
Color Labels

You can use these ratings any way you like. The most important rule 
is to be consistent.

Perhaps a Flag is any image you may want to use later.

Stars could tell you how much you like it. Save a five-star rating for 
only the best of the best.

Colors could mean a particular use. Red for the web, yellow for family, 
etc.

Or, maybe you want to keep it simple and only use the Flag rating. 

Or, you’ll find your own method.  The quicker you can settle on a 
system, the more valuable the rating system becomes.

•
Quick Keys worth 

learning:

PUX
P - flags a photo
U - unflags
X - flags as reject

0-5 - adds star 
ratings

6-9 - adds color 
labels

•
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This shows the ‘expanded 
view’ in Grid View. 
Use the ‘J’ key to toggle 
through various views.
You can customize what is 
displayed by going View>View 
Options...

In this display, you can see the 
various ratings as well as the 
file name, type and size of the 
image.
Customize this to fit your 
needs.

This shows Loupe View with 
Info displayed.

Use the ‘I’ key to toggle 
through two different displays 
or turn it off.

Customize what is displayed by 
going View>View Options...

•
IN GRID VIEW
J - toggles through 
what is displayed 
around the image

⌘J - displays view 
options

IN LOUPE VIEW
I - toggles through 
what is displayed

⌘I - displays view 
options

T - toggles toolbar 
on and off

\ - toggles search/fil-
ter bar on and off

To see and set your ratings, make sure they are displayed in the tool 
bar below the images. 

If you don’t see the ratings, use the drop down window to select 
what is displayed.
Watch a 7:04 video on using ratings and labels

http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#ratings
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Collections

Think of Collections as virtual folders, another way to organize your 
images within Lightroom.

Collections are NOT real folders that exist on your hard drive. They 
don’t add file size or copy images. They are a way to view a particular 
group of photos within Lightroom.

For example, you might have photos of your dog taken over many 
years and stored in many folders. You could create a Collection of 
your dog photos. The original files would remain. The Collection would 
just let you view them all in one place.

Create a Collection

Select photos from a folder displayed in Grid Mode

Click the + next to Collections and Create Collection
Give it a name and click Create.
Voila, you’re done

•
Once nice feature 
of Collections is that 
you can reorder 
photos by clicking 
and dragging within 
the Grid View

•

You can also delete 
images from a Col-
lection. Simply click 
on the photo and hit 
the delete key.
The original file and 
folder aren’t altered. 
The image is just 
removed from the 
Collection.

• Smart Collections

Think of Smart Collections as automated Collections. You can set 
them up to collect together any photos with a particular attribute. You 
could, for example, gather all your three-star photos into a Collection. 
And anytime you rate a photo with three stars, it would automatically 
be added to that Collection.
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There are default Smart Collections already created by Lightroom. You 
can create your own, with your own set of attributes/filters easily.

These are Smart Collection 
that Lightroom created.

You can create your own as 
well.

Any photo added to Light-
room will automatically be 
added to the appropriate 
Smart Collection

To create a Smart Collection give it a name, set the attributes and 
click create.  Any photo (or video) with those attributes will be 
added to the collection.

Watch a 6:06 video on creating and using collections

http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#collections
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Editing Photos

Lightroom has it’s own tools for adjusting and toning photos. But you 
may want to work in Photoshop either because:
A. You are more familiar with Photoshop
B. You want to make changes that are only possible in Photoshop.

The advantage of Lightroom - one stop shopping. You can adjust and 
tone photos without ever leaving Lightroom.

The disadvantage is that Photoshop is a more powerful tool and not 
everything you want to change is possible inside of Lightroom.

Let’s look at some basic adjustments you can make to a photos inside 
of Lightroom

Captions

Captions are vital

	 Captions give photo context and meaning

	 They explain what is happening in the image

	 They give facts and details the image alone can’t explain

	 They are searchable - this is key. 

	 They make your photos more valuable 

•
Changes in 
Lightroom are 
non-destructive.

This means if you 
change the color, 
brightness, crop-
ping of a photo in-
side Lightroom you 
can always undo it 
at a later date.
 
Pretty cool!

•



Lightroom Classic

      Tips & Tricks

updated May 2019
23

Captions are applied in the Library module

Select a photo and then click on the Metadata Tab on the right.

There are many fields you can complete. All of this information is 
attached digitally to the image file - collectively this data is called 
metadata – it is data about data. Information about your photo. 

This information can be viewed in applications other than       
Lightroom - clients will be able to read your captions, Websites can 
import it, etc. 

Develop Module
The develop module is where you’ll adjust your image - crop, tone, 
etc. 

Select a photo in the Library module and then click the Develop 
Tab

•
Remember that 
basic caption      
information can 
be applied to a 
group of images 
when you first 
import them into      
Lightroom.

Basic facts about 
the photos – who, 
what, where, 
where and why – 
can be attached to 
all the photos in a 
single shoot.

Then specific 
information can be 
added photo by 
photo.

•
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Note the various panes in the Develop Module

Presets – Some prebuilt filter sets that you can apply to your im-
age.  Rollover a preset and you’ll see the change . Click on the pre-
set to apply it to the image.  Click the Reset button to remove the 
preset.

Filmstrip – all the images in the folder are visible at the bottom 
of the Module. Use the arrow keys to scroll through other images.

Toning Tabs – Multiple options for altering and adjusting your 
photos can be found in the various tabs on the right starting with 
Basic. 

•
THIS IS 

IMPORTANT

Lightroom is a very 
powerful tool and you 
can make all sorts of 
changes to your image.

BUT, just because you 
can doesn’t mean you 
should.

Changing the content 
of a photo - remov-
ing something, chang-
ing a color or tone,          
distorting the image – 
changes the meaning. 

If you are a journalist 
there are very strict 
ethical guidelines that 
limit what you can do 
to a photo.

But other photogra-
phers should be wary 
as well about altering 
images. Consider why 
you’re making changes 
and how people will  
respond to a photo 
that no longer accu-
rately represents the 
reality of the scene.
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BASIC

The controls in the basic tab let you adjust color, brightness and 
saturation.

The original image is on the left. 
(The “Before and After” tab at the bottom allows you compare the 
image as you tone it - a useful feature)

The Basic panel is the first and primary panel you will use to adjust 
your images. Often it will be the only panel you need to use.

•
Not everything can 
be fixed.

It is very important 
to get a proper 
exposure in the 
camera. While Light-
room and Photo-
shop are powerful 
tools they are not 
magic.

Blurry photos can’t 
be magically made 
to be in focus or 
sharp.  

Highlights and shad-
ow areas that are 
missing details can’t 
be fixed.

“Fixing” a poor im-
age has its limits.

•
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Local Adjustments

You may need to adjust part of an image - darken a sky, lighten a 
face, adjust the color in one area of a photo.

Lightroom offers limited tools for making these kinds of adjustments.

Photoshop offers much more control over local adjustments.

Clicking on the tools at the 
top will open the adjustment 
window.

Each tool allows you to selec-
tively adjust part of the image.

Crop tool allows you 
to crop and straighten 
an image.

Spot removal - can 
remove or clone con-
tent from one part of 
the image to another.

Red Eye Correction 
for removing red eye

Graduated Filter can 
create a graduate 
band of adjustment 
to darken a sky for 
example.
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Radial Filter can create a round or oval area of adjust-
ment.

Adjustment brush allows you to paint over an area of 
the image adjusting color, brightness etc.

Watch a 14:21 video on using the tools in the Develop Module.

Editing in Photoshop

If you need to use Photoshop to further adjust an image, simply 
right-click or control-click(Mac) on an image and select Edit In, 
and then select Photoshop.

(This requires you have Photoshop installed on your computer)

You’ll get this dialogue box:

Selecting the top option, Edit a 
Copy with Lightroom Adjust-
ments, usually makes the most 
sense. This will preserve the 
original image and allow you to 
further adjust the image after 
making corrections in Light-
room.
The only downside is you’re 
adding an image to your collec-
tion which will increase the size 
of your image collection.

http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#develop
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Exporting

Ultimately your photo does you no good sitting in Lightroom.

You want to use it - post it to the web, publish a book, email it to a 
friend.

To do this, you need to export the image from Lightroom.

To Export
File>Export...
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You have a lot of choices.

You can select different file formats, image size, quality, etc.

Jpeg: compressed files, good for emailing and the web. 
Resize the image if you know the size you’ll need.
Lower the quality setting for smaller files that are quicker to upload 
and email. 
sRGB is the usually the best color space for viewing on a computer.

Tiff: uncompressed files. These will be larger files and are not de-
signed for posting online.
They work well when editing in Adobe Premiere or other video edi-
tors.

watch a 2:42 video on exporting your images from Lightroom.

This tutorial didn’t explore other modules in Lightroom.  Lightroom 
can export to the web, publish books, slideshows etc.

Further information about the program can be found at 
www.adobe.com.

www.Lynda.com (free to Penn State students at Lynda.psu.edu) is 
another great resource.

http://www.willyurman.com/teaching/handouts-2/lightroom-video-tutorials/#export
http://www.adobe.com
http://www.Lynda.com
http://Lynda.psu.edu

